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I. FCPX Media Management
Final Cut Pro X (FCPX) is a database, metadata based non-linear
editing (NLE) system. It is the quickest, most affordable, and
easiest professional editor to learn on the market today. Once
learned it is a very powerful system to work with, in conjunction with
Motion 5 for graphic and template work, and Compressor 4 for
transcoding work. This document will attempt to explain the basics
of FCPX media management to help you quickly gain a level of
basic proficiency.
*A video version to accompany this document may be released in the near future.

A. Physical Storage & Libraries
Physical storage medium can take the form of hard drives, be they
spinning disk (HHD) or solid state (SSD) and any combination of
those (RAID, NAS, etc). The Library is the equivalent of a “project
file” used by other applications, and resides on physical storage
medium of some type. Thus the Storage Medium name is the top
level of media management, and the Library name is the second
level of media management, as we will see.
1. Storage
The top level of FCPX media management is your storage medium.
This can be a 7200rpm hard drive connected directly to your Mac, a
RAID system, a networked NAS system, a centralized server via
Ethernet, Fibre or conceptually an online service. Each has pros
and cons not covered here. The most common are secondary
drives and RAID systems directly connected to the Mac edit bay.
These must be a very fast connection types, either USB 3.0 or
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Thunderbolt. Note that 5200rpm drives, USB 1/2 and Firewire are
unacceptable for today’s 720 to 8K video formats.
Storing FCPX work on the system drive is not recommended. The
operating system and applications need to write hidden, temporary,
working files non-stop and very quickly. This eats up the limited
bandwidth the CPU uses to access the system drive. Video editing
utilizes multiple simultaneous streams of video, audio and metadata
in real-time and needs all the bandwidth it can get.
Also, a drive equal in capacity (speed doesn’t matter) to the
secondary drive your Libraries and media are on should be
incorporated for a nightly backup. Drives die without warning, new
and old, that’s a fact of life. A regular backup WILL one day save
your professional life one day. It has for me on several occasions.
This is not an “if” situation, this is a “when” situation.
Network systems can get more complex and you should consult a
network specialist who is well versed in Apple and FCPX systems
to configure these types of storage.
2. Libraries
The FCPX Library resides on a drive somewhere, as discussed
previously. Thus, they are physical entities, a bundle of electronic
digital databases and files on a physical hard drive. Thus, a Library
can be physically moved, copied, even damaged (nightly backups,
please).
Any number of Libraries can be on one drive, or multiple Libraries
can be spread across multiple drives. Two Libraries on the same
drive can share the same name, although logistically this would be
very bad practice. Obviously Libraries can be moved or copied
between storage locations, which will be discussed later.
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Thus an FCPX Library is a container that holds the media,
databases, and generated files the application needs to do its work.
To track Libraries on a Mac system easily, here is a guide for
creating a Smart Folder in the Finder.

http://finalcutprox.guru/blogs-main/techniques-blog/files/smart_folders.html

Inside of the FCPX application, the upper left of the window is the
Library Browser, where we see currently open Libraries, their
Events and Collections, but not the media assets. Those are
viewed per each Event in the Event Browser. More on that later.
B. Managing Physical Media
Managing media in FCPX is done on two planes: physically with the
actual files on the storage medium, and digitally with metadata. We
have covered the physical storage medium and what a Library is.
Now let’s look at the actual media files themselves and how FCPX
manages them physically.
1a. Original Media
Original media are the files that were generated by your camera. It
is advised to have a backup drive you keep exact duplicates of
these. You can make these manually or let FCPX do it. In the
Import window select a camera card in the left hand pane. Then in
the lower left, click the Create Archive button. This will create an
exact duplicate (with an FCPX metadata file) for FCPX to access
later. This is also the preferred method if you want to edit directly
from the original camera card structure.
1b. Optimized Media
Optimized media is a ProRes version of your Original media. This
is used when your hardware is not able to playback and edit highly
compressed Original media well enough. It is not normally
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recommended to import Original media and create Optimized
media at the same time. Use of one or the other is the typical
workflow, but there can be exceptions. This means choosing Leave
Files In Place and Create Optimized Media while in the Import
window.
Optimized Media can be created in the Import window by selecting
Create Optimized Media. It can also be done later in the Browser
by selecting one or more clips at once, right-click, then select the
Transcode Media option.
Note that file playback ease or difficulty to the computers is based
on compression, not file size. The more highly compressed a video
file is, the more muscle required to play it back due to decompression issues.
1c. Proxy Media
Proxy media is a 1/2 quality version of your Original Media. It is the
same frame size and rate, just 1/2 of the image data/resolution. It
is not meant to color grade or do detailed masking with. Also, it is
not meant to export with, unless you want a proxy version for
simple reviews.
Video files are transcoded into ProRes Proxy codec, and still
images are transcoded into JPEG, unless there is an alpha channel
then it is transcoded into PNG. Audio MP3 files are transcoded into
MOV files. Originals of these are retained for online editing and
export.
The exception are UHD, 4K, 8K, etc. video files, when a 1080
frame size (but same frame rate) file is created in ProRes Proxy
codec.
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Creating proxies can initially be done in the Import window by
selecting Create Proxy Media. After importing, it can be done in the
Browser by selecting one or more clips at once, right-click, then
select the Transcode Media option.
During the editing process, you can decide which version FCPX will
work directly with by going to the View menu in the upper right of
the Viewer. The Media section of that menu will allow you to
quickly switch between using Original/Optimized or Proxy media.
For final exports always be sure to change this setting to Original/
Optimized!
2a. Managed Media
Managed media is when FCPX stores media inside of a Library,
physically. In the Import window you’d choose “Copy To Library”.
You can verify this by selecting a Library in the Browser, going to
the Inspector, click “Modify Settings” and verify Media and Cache
are set to Library.
2b. External Media
External Media is when FCPX references media that is physically
stored outside of the Library. In the Import window you’d choose
“Leave Files In Place”. Again, you can verify this by checking the
Library’s settings in the Inspector as above.
When media is External, FCPX creates an alias of it inside the
Library. An alias (or link file) is a file that is only a few kilobytes in
size, and simply points to where the original is.
For more information about how FCPX uses UNIX link files, see
this tutorial.
https://youtu.be/OrmwWdTkrbQ

2c. Migrating Managed Media To External Media
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If you want to convert a Library from Managed Media to External
Media, select the Library in the Browser, go to the Inspector, click
“Modify Settings”. Then for the Media setting, select “Chose” and
pick a folder somewhere to store the physical media in and click
OK. Then in the Inspector, in the Media section, click the
“Consolidate” button.
This moves (not copies) all media to the folder you designated, and
then replaces the original physical media inside the Library with
aliases (see External Media above).
2d. Migrating External To Managed
If you want to convert External Media to Managed Media, select the
Library in the Browser, go to the Inspector, click “Modify Setting”.
Then for the Media setting select “Library” and click OK. Then in
the Inspector, in the Media section, click the “Consolidate” button.
This copies all media from the external folder to inside the FCPX
Library, as it will not touch external media. Now you will have two
physical copies of your media; one in the external folder, one inside
the FCPX Library. Do what you wish with the external folder, FCPX
is no longer concerned with it.
3a. Motion Templates - External (default)
All effects, transitions, titles and generators that are created in the
Motion 5 application are stored in your user home folder, in the
Movies folder, in the Motion Templates folder. This is the default.
When you share templates with others, this is where you get them
from, and copy them to.
Note that not all of these are created in Motion. Some are created
with coding using the FxPlug markup language, along with possible
code from Quartz Composer, XCode or other programming
languages. When these coded “plugins” are installed, they are not
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in the Motion Templates folder, but can be spread across various
system library level locations.
3b. Motion Templates - Internal
There are situations when you desire to move the Library to
another Macintosh system that has FCPX installed on it. It may not
have all the Motion created templates that the original had installed.
In this situation select the Library in the Browser, go to the
Inspector, click the Modify Settings button. For the Motion Content
setting change it to “In Library” then click OK. Finally, in the
Inspector, in the Motion Content section, click the “Consolidate”
button.
FCPX copies (originals are left untouched, in place) only those
templates used in the Library to be physically stored inside the
Library.
To verify, when browsing templates in FCPX, you will see a menu at
the top right of the template browser which gives you two settings
to chose from. One option is labeled “Installed” and the other will
be labeled with the title of that specific Library. Installed looks at
what is installed in the Motion Templates folder. The other will show
what has been copied to inside of the Library.
4. Moving Libraries
On the most basic level, you can duplicate to the same drive, or
copy to another drive any Library as is, simple as that. There are
caveats to be be aware of.
If you have External Media, or if you’re moving this Library to
another Mac, you’ll want to verify all your Media is Managed and
that your Motion templates are set to be stored inside the Library.
Once that is verified, to be safe, click the Consolidate buttons in the
Inspector for both.
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If you want to keep your media external when moving/copying a
Library to a new drive, copy the FCPX Library to its new location on
the new drive, then copy the folder(s) with the external media to
that same drive. Since FCPX is looking for the original drive name,
you may have to Re-Link (File menu) the media when opening the
new copy of the Library on the new drive.
5a. Generated Files
FCPX can generate files as the post-production process moves
alone. These are Cache, Render and Backup files. Optimized and
Proxy files are also a form of Generated files, but they’ve been
covered previously. Generated files discussed here, as well as
Proxy files (and usually Optimized files if the original files are not
detailed) files can be deleted when a Library is ready to be
archived, as FCPX can recreate them later.
5b. Generated Files - Cache
Most of the time you can leave the Cache file location inside the
Library. These are analysis, render, thumbnail and audio waveform
files that FCPX uses to work efficiently. In rare instances you may
want to store these files externally. To do this, select the Library in
the Browser, go to the Inspector, click the Modify Settings button.
For the Cache setting change it to a folder on a drive. Cache files
will be written to that location from that point on.
5c. Generated Files - Render Files
Render files are created only when the render command is enacted
via one of three ways. Background Rendering runs automatically, (I
recommend turning this off in the preferences), or by using the
Render All command, or the Render Selected command. The later
two are found in the Modify menu.
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Often we want to delete these to save space for archiving or to
troubleshoot an issue. To do this select a Library, Event or Project
in the Browser. Go to the File menu, to the “Delete [Library/Event/
Project] Generated Files” function. There you can chose to delete
unused or all render files, as well as Optimized and Proxy media if
desired. This option also allows you to delete Proxy and/or
Optimized media, also.
5d. Generated Files - Backups
FCPX automatically makes database backups of active Libraries.
These are stored in the users’s Movies folder by default in a “Final
Cut Backups” folder. To change this, select a Library in the
Browser, in the Inspector click Modify Settings. The Backups
setting menu allows you to chose the default location, a new
location, or to simply not save backup files at all.
Note these are database backups of a Library and do not contain
any media at all. To backup media, use an application such as
TimeMachine or Carbon Copy Cloner to copy whole Libraries, as
well as all External Media to a backup drive on a regular basis.
C. Managing With Metadata
As stated before, managing media in FCPX is done on two planes:
physically with the actual files on the storage medium, and digitally
with metadata. Metadata is “data about your data”. The 1’s and 0s
that make up the video you see playing is the “data”. Metadata is
digital information about that video, and is either embedded in the
video file itself, or created and stored by FCPX in its internal Library
databases. Metadata for a video file can contain information such
as frame size, frame rate, data created, last date modified, Role
assignments, audio channel configurations, color space
information, camera type, aperture setting, etc.
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1. Library Browser - Events
An Event is a container inside of a Library. Physically on the drive it
is a folder inside the Library that you don’t see or interact with
directly. You as an editor access Events via the Library Browser.
Multiple Events can be created within a Library. Events contain
your media and Collections. Collections will be cover later. Thus,
Events are the third level of media management in FCPX (Drive >
Library > Events).
Inside the FCPX Window, in the Library Browser, with an Event
selected, the Event’s contents are displayed in the adjoining Event
Browser. This Event Browser can be toggled between Filmstrip
View and List View, both very literal descriptions.
Inside this Event Browser pane are some of FCPX’s most game
changing, powerful, flexible and easy to use media management
tools.
2. Event Browser - List View Columns
You can sort/search for media assets in the Event Browser’s List
view. These columns are based on metadata and physical
characteristics of your media assets.
Right-Click any header in the Event Browser’s List view for the
menu to configure what columns are shown or hidden. You can
also click and drag headers left and right to further customize their
layout. Clicking on a header will sort the contents by that criteria.
Clicking repeatedly will toggle between sorting in ascending and
descending order.
3. Roles
Role metadata comes in two flavors; Video Role assignments and
Audio Role assignments. These can specify what the purpose an
assets or its components play in the production. There are the
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factory default roles, but you can also customize your own Roles.
Each Role can also contain one or more Sub-Roles. Any place in
FCPX you can right-click an assets, or see its metadata in the
Inspector, you have access to Role assignments and editing the
Roles used in that Library.
Note that Roles are Library specific, so that customizing them in
one Library will not translate into other Libraries automatically.
4. Ratings
In FCPX we can assign one of three Rating to assets. These are
Favorite, Rejected or Unrated. You can assign these to either an
entire asset in the Event Browser, or to one or more Ranges in an
asset. Once assigned, a colored bar of either green or red is
placed along the top of the filmstrip thumbnail of that asset in the
Event Browser to indicate the Rating status.
To assign a Rating, select an asset in the Event Browser. If desired
select a specific Range within that asset. Then use of of these
keyboard shortcuts: F for Favorite, green bar. Control-Delete for
Rejected, red bar. U for Unrated, no color bar assigned.
If a Rating is assigned to a range on a clip, and the same rating is
applied to a new, overlapping range, the two ranges combine as
one.
5. Used Media
This is similar to Ratings above in that an orange bar is placed
along the bottom of the asset’s thumbnail when viewed in the Event
Browser. Yet a Used Media Rating is assigned automatically when
an asset, or a Range of an asset is used in a Timeline. To see
these, go to the View menu, to the Browser sub-menu, and make
sure a check is next to Used Media Ranges.
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6a. Library Browser Collections - Finder Metadata
FCPX recognizes Finder metadata; specifically Folder names,
Finder Tags and Finder Keywords. Thus one could organize media
on-location without FCPX, in the macOS Finder, using folders,
Finder Tags and Finder Keywords. When importing into FCPX, the
Import window’s right hand pane allows you to specify assigning
FCPX Keyword Collections (see below) according to folder names,
Finder Tags and Finder Keywords.
Note that I specify “Finder” with these titles because what the
Finder assigns a file is not using the same database as when FCPX
assigns these to a file.
To create a Folder in the Finder, go to the File menu and select
New Folder. To create a Tag, right-click a file in the Finder, and
select a color dot. These color dots are Finder Tags. To assign a
Finder Keyword, right-click a file in the Finder, go the word “Tags…”
above the color dots. This allows you so assign custom keywords
to files in the Finder.
6b. Library Browser Collections - FCPX Keywords
Keyword collections gather media assets according to customized
keywords the editor has assigned to media assets. Media assets
are manually added to Keyword Collections. If new media is then
imported into the Event, it must manually be added to that
collection.
To create a keyword collection, select a media asset, Command-K
brings up the Keyword Editor, then type a keyword into the text
field, hit enter and that asset has been assigned that keyword. No
assets are duplicated at all, this is all simply assignments in the
Library’s internal database.
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Or you can right-click an Event and choose New Keyword
Collection. Then rename it to be the keyword you wish it to
represent.
You can also select one or more assets at once and drag them to
an existing Keyword collection to add them.
Be aware that Keyword Collections are not limited to a single word,
they can be multiple words making up a single collection. Also, this
does not duplicate any physical media.
6c. Library Browser Collections - Smart Filter Collections
Smart Collections gather assets together based on specific physical
characteristics and/or metadata the editor specifies. Media assets
are added to these automatically once the criteria is set. If new
assets meeting the criteria are then imported, they automatically
join that Smart Search Collection.
To create a Smart Collection, click on the Search Field icon, the
magnifying glass at the top right of the Event Browser. Then click
the Filter HUD icon just to the right of the text search field. Assign
criteria, then click the New Library Smart Collection button in the
lower right.
You can also right-click an Event and choose New Smart
Collection. Then rename it something descriptive and double-click
to open the Filter HUD to assign or change criteria.
6d. Library Browser Collections - Folders
Folders are simply folders, which you can drag Keyword Collections
and Smart Collections into. For example; I can gather all audio
only media, audio media that is grouped a music, others grouped
as voice overs, and others grouped as sound effects in various
Smart and Keyword Collections, into a Folder that is titled Audio
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Assets. This helps speed access to those assets, and save in my
Library Browser real estate.
To create a Folder right-click an Event and choose New Folder,
rename it something descriptive, then drag your desired collections
into it.
7. Metadata In The Inspector
Select an item in the Browser or Timeline (Library, Event, Project,
media asset) and in the Inspector’s Info section is all the metadata
for that item. Some metadata can be customized, some is set in
stone, some simply doesn’t exist for that file and isn’t pertinent.
You can also customize these views. Operations such as
searches, multicam configurations, and other functions will rely on
this metadata.
C. Audio Channel Configuration
FCPX can handle audio based on metadata very easily. Channel
configurations and Roles help to make an editor’s job much easier
and manageable.
1. Channel Settings
Audio files can have one, two or more channels inside of them.
Video files containing audio are the same. For example, a video file
recorded with two microphones, one in the left channel and one in
the right channel, will import with both channels configured in some
default configuration. This configuration can be changed with
metadata which will never change the original physical file on the
drive itself. A stereo pair can be reassigned to be dual mono
channels. A 5.1 surround audio file can be changed into 6 mono
channels, or groups of stereo pairs with mono channels, etc.
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To reassign audio channel configurations, select a media asset in
the Event Browser that contains audio. Go to the Inspector, to the
audio section, and towards the bottom is the Audio Configuration
block. The upper right how the waveform display here has a menu
that states the asset’s current configuration. Open that menu to
reassign the channels to your liking.
Note that once an asset is in a Timeline, changing its channel
configuration will have no effect on the original copy in the Browser.
D. Managing Timeline Media
In the Timeline media assets can be managed by a variety of
metadata. This helps with identifying media at a glance or by
arranging assets into groups called Lanes.
1. Clip Identification
In the upper left corner of each asset in a Timeline is the asset’s
own name. By default this is the name it came in with from the
Event Browser. You can right-click an asset in the Timeline and
chose Rename Clip. This will have no effect on the original in the
Event Browser.
From the Clip Appearance menu, top right of the Timeline pane,
there are three options, each can be enabled or disabled, as to
what is displayed as the Clip Name. These are Clip Name, Angle,
Clip Roles.
2. Clip Icon
Specialty clips have icons in front of their name in the Timeline.
There are icons to indicate Compound, Multicam, Sync and
Audition clip types.
3. Timeline Index
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The Timeline Index in general allows us to list all used assets in
order, search for, organize and get great advantage from metadata
of all types when working in the Timeline. Please see the FCPX
Help document for more details, as they are too extensive to cover
in this article. A link is provided at the end of this document.
4. Role Lanes
In the Timeline, Roles are represented by the clip being that
assigned color to match. But all clips below the Primary Storyline
are grouped by Audio Role. Which appear over or below which is
determined in the Roles section of the Timeline Index. Dragging
the Audio Roles into various orders will be reflected in clips of those
Audio Roles moving above or below each other in the Timeline.
Also, Lanes can be segregated off, expanded into Sub-Role lanes
and soloed. Please see the FCPX Help document for more details,
as they are too extensive to cover in this article. A link is provided
at the end of this document.
E. Managing Exported Media
FCPX offers some convenient ways to manage media upon export
(Share). These are simple, yet handy little tools that can help make
an editor’s day flow smoothly.
1. Export - Metadata
Before exporting from FCPX, select the asset or Project in the
Browser. Go to the Inspector, to the Info section. There you can
customize some of the metadata for exporting an asset. But for
Projects you can customize much more.
Select a Project in the Browser and go to the Share section of the
Inspector. Here you can assign and modify automatically added
metadata and manually added metadata. You can configure
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layouts of what metadata to include or not. To the right of the
“Attributes” header is a menu that allows you to show or hide
metadata fields including copyright, title, tags, genre and much
more.
2. Sharing (Exporting) - Tracking
In the section of the Inspector previously discussed for the
metadata of a Project, in the Share section, in the upper half of this
pane will be the metadata that will be embedded in the Shared
(exported) file. This is customizable via the menu in the upper right.
In the lower half of this pane is found a record of each time that
Project was Shared with time and date. A menu to the right of each
entry allows you to “Reveal In Finder” if that exported file still exists
in it’s original location. If it has been moved or deleted, the link to
find it won’t work.
E. Conclusion
FCPX offers a great deal of powerful and flexible media
management tools. This document only covers the very basics. To
find more information, please reference these online documents
from Apple.
Final Cut Pro X Help
http://help.apple.com/finalcutpro/mac/10.3/
Managing Media With FCPX Libraries
https://www.apple.com/final-cut-pro/docs/Media_Management.pdf
FCPX Ecosystem - Asset Management
https://www.apple.com/final-cut-pro/resources/
ecosystem.html#asset-management
20

About Apple ProRes
https://support.apple.com/en-us/HT202410
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